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1.0 Using Online Help 
The Expedite Bid Manager’s Online Help system, a companion online file, covers the 
Expedite components used by the bidder. To access  the BID online help while you have 
the program running, press the F1 button on your keyboard. A window containing the 
contents of the online help system will be displayed. 
 

CONTACT INFORMATION 
 
For information about this product contact: 
 
Customer Support 
Info Tech, Inc. 
5700 SW 34th Street 
Suite 1235 
Gainesville, FL 32608 
Phone: (352) 381-4400 
Fax: (352) 381-4444 
 
E-mail: customer.support@cloverleaf.net 

 
2.0 Setup 
BID is a 32-bit application for Windows 95, 98, 2000 and NT. 
 
2 Note: For full functionality, the BID program should be installed using the instructions in 
section 2.1.  
 
¢ Warning: Trns•port Expedite 5.1a contains underlying program code that 
incorporates strong encryption technology and is therefore subject to export 
restrictions. Its distribution may be regulated by 15 CFR Parts 730-774, 
published by the U.S. Department of Commerce, Bureau of Export 
Administration, as the Export Administration Regulations (EAR), and probably 
other laws and regulations. Except for export to Canada for use in Canada by 
Canadian citizens or lawful permanent residents, Trns•port Expedite and any 
underlying technology may not be exported outside the United States or to any 
foreign entity or “foreign person” as defined by U.S. government regulations, 
including without limitation, anyone who is not a citizen, national, or lawful 
permanent resident of the United States. Trns•port Expedite is available within 
the U.S. It may not be exported outside the U.S. Be aware that if you export 
this software outside the U.S., you may be in violation of U.S. laws. 
 
 
2.1 Installing BID  
The setup program for BID is located on the Contracts Administration Office web site: 
http//www11.myflorida.com/cc-admin.  Contractors are required to download the setup 
program from the Internet on to their computer. 
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Installing BID from the Contracts Administration Office web site for 
Windows 95, 98, 2000 or NT 
Follow these steps to install the Expedite BID application software from the web site: 
1. Go to: http://www11.myflorida.com/cc-admin. 
2. Click the link for Expedite.  
3. Click the link for Expedite Bid Setup File.  
4. Click the link for Expedite Bid 5.1a Setup (zip file). 
5. Select save this file to disk and click OK. Select a location to download the file. 
6. After downloading the file and unzipping it, you ready to install the program. 
7. Click the START button and choose Run. The Run window appears. 
8. To install the application software, type the location the file (example: C:\Setup.exe) 
    was unzipped to in the Open text box. Or you can use the BROWSE button to 
    select the Setup.exe file. Click OK. 
9. The Expedite BID Setup program will begin.  Follow the instructions given in the 
    setup program. 
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3.0 Using Expedite for Bidding 
Bidders use only one component of Expedite, BID, which they install on their computers 
using the installation program. 
 
3.1.1 BID (Bid Manager) 
BID is an interactive, spreadsheet-like program used by contractors to enter their unit 
price bids. It enables a bidder to produce both an electronic and paper-based bid. BID 
also supports the merging of electronic amendments with existing electronic bids and 
electronic bid submission with digital signatures. BID is created by the SETUP.EXE 
program. 
 
3.1.2 SETUP (Bid Manager Installation Program) 
Contractors use the Setup.exe file to install BID from the distribution diskette. During 
installation, contractors are not required to enter their bidder ID, name, address, and 
phone number. The bidder ID is now maintained within the BID program itself. The first 
time the program is used, however, the system will prompt the contractor for a bidder ID 
and other required fields. 



FDOT Expedite BID Manual 
 

                                                     Page 6 of 42  
 

 
4.0 Making the Bid 
This tutorial section is intended for prospective bidders. It is included here in much the 
same form as it appears in Bid Manager’s Online Help. We recommend following the 
steps in order for you to grasp a better understanding of the overall bidding process. 
Once a contractor has opened the electronic proposal and modified it within the BID 
program, the proposal is then referred to as a bid. The BID program allows prospective 
bidders to interactively enter their unit price bids and produce both electronic and paper-
based versions for submission to FDOT. Each time the electronic bid is modified, it will 
be marked with a unique revision number. The paper-based bids will display this revision 
number so that the wrong copy is not accidentally submitted.  FDOT can verify that the 
two versions are the same. 
 
After an Expedite proposal has been opened into the BID program, the bidder can load 
and incorporate Expedite amendment files. BID only allows amendments to be loaded in 
sequential order. Amendments can change general proposal data (such as descriptions 
and amendment notes) and item data (such as quantities), as well as adding or deleting 
items. Changes to item data will not change unit prices previously entered. 
 
BID may contain a DBE List window that can be used to track DBE (Disadvantaged 
Business Enterprise) commitments, or MBE (Minority-Owned Business Enterprise) and 
WBE (Woman-Owned Business Enterprise) commitments. This section of the program is 
used to track line items assigned to registered DBE, MBE and/or WBE suppliers, 
subcontractors, and manufacturers. Total subcontractor commitments can be compared to 
the overall proposal goals for DBE/MBE/WBE commitments.  FDOT is not currently 
requiring DBE Commitments to be entered in Expedite BID.EXE bid program 
 
The BID program may also contain a Miscellaneous Data Entry screen. The Misc Data 
Entry Screen can contain anything that  FDOT would like the bidder to record. Any 
questions can be displayed for the bidder and any of the bidder's responses can be 
printed. Information that is entered on the Miscellaneous Data Entry screen, however, 
never gets passed back to FDOT's bid letting system. Some DOTs use this screen to 
display contractual information for bidders and use it as a checklist to ensure that all 
elements of the bid process have been completed. 
 
The following BID tutorial requires that you have the following: 
n BID program 
n Tutorial files 
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4.1.1 Opening Electronic Proposals 
After you receive your electronic proposal from FDOT, start the BID program so you can 
begin entering your bids. 
 
1. Double click the BID button. 
 
2. Select Open from the File menu to open an electronic proposal. 

 
The File Menu on the Main BID Window 
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3. BID displays the Open Files window with a list of available .ebs files. Select the file 
you wish to load from this list and click OPEN. BID displays a split window with the 
proposal identified in the title bar. 
 

 
Proposal Window 
 
The left pane of the window displays a tree view of the proposal and the right pane 
displays general information about the proposal. You can adjust the width of the panes by 
placing the cursor over the border between the two panes until the cursor turns into a line 
with arrows on each end. Then press the left mouse button and drag left or right to adjust 
the width of the panes. The panes maintain these new widths until you change them 
again. 
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Opening and Closing Folders in Tree View 
When a proposal is first opened, the proposal folder is displayed in the left pane of the 
proposal window, but the folder is closed. To the left of the folder icon is a plus box [+]. 
Click on the plus box [+] to expand the tree view hierarchy for that proposal. Notice that 
the plus box [+] has changed to a minus box [-]. You can collapse the tree view again by 
clicking the minus box [-]. 
 
You will see at least one folder labeled Schedule of Items listed under the proposal 
folder. If your agency has decided to use the DBE List and Miscellaneous Data 
functionality, then those folders will also be displayed. 
 
2 Note: If you open a proposal that has no type of DBE goal assigned to it, the 
DBE List folder will not appear in the tree view even if that option is being used 
by your agency. 
 
Double clicking on any folder in the tree view will open that folder and display related 
information in the right pane of the proposal window. 
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4.1.2 Entering Bids 
After you have selected the .ebs file, the next step is to enter bidding prices for the 
Schedule of Items. 
 
1. Click the plus box [+] to the left of the Proposal number in the left pane of the 
window. The tree view expands. 
 
2. Click the Schedule of Items folder on the left side of the window. BID displays 
general information about the proposal and the number of sections and items it 
contains. 
 

 
 Schedule of Items Information (TREE MODE) 
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3. Select Item Grid from the View menu. BID displays the Schedule of Items in grid 
form on the right pane. 
 

 
 Item Grid 
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4. Move the cursor to the first line item on the right side of the window. Type the 
amount you want to bid. Press the TAB key. BID computes the Extension, the 
Section Total, and the Bid Total immediately. 
 

 
 Entering Bids for Line Items  
 
5. Repeat this step to bid on the rest of the line items. 
 
 
2 Note: To change a unit price, click the selected item and enter a new 
amount. If you just want to make a small change to a unit price (such 
as changing one digit), you can edit the unit price by using the Left 
Arrow and Right Arrow keys to move the cursor to the selected digit. 
Delete that digit with the DELETE key, and enter a new digit. 
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6. Click the CHECK BID button on the toolbar to check the status of the bid. BID 
displays the Bid Errors Log window, which lists any errors that may have occurred. 
Resolve errors regarding the Schedule of Items before moving on to the next section. 
If  FDOT does not require any more information in regards to your bid, and if your bid is 
clear of errors, you can send the bid back to FDOT. 
 

 
 Bid Errors Windows 
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4.1.3 Tracking Line Item DBE Commitments 
Depending on your installation options, you can use Expedite to track either DBE 
commitments, or MBE and WBE commitments as agreements are made with 
subcontractors. In addition, a report is available showing DBE, or MBE and WBE plans 
to meet the appropriate goal(s) for the proposal. 
 
2 Note: Depending on your agency settings, the PES file is modified for 
enhanced DBE processing. If you have questions about your agency 
settings, contact FDOT Contracts Administration Office. 
 
FDOT is not currently requiring DBE Commitments to be entered in 
Expedite BID.EXE bid program. 
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4.1.4 Filling Out the Misc. Data Entry Form 
Now that you have met the DBE requirements, it is time to fill out the Miscellaneous 
Data form. It is the decision of  FDOT to include the Miscellaneous Data form as part of 
the proposal. You may not have this screen at all. 
 
1. Click the Miscellaneous Data window option on the left side of the window. The 
Miscellaneous Data window appears  
 

 
Miscellaneous Data Window 
 
The Miscellaneous Data window contains information that  FDOT would like you to 
record. Any type of form for gathering miscellaneous information can be created. Some 
DOTs use this screen to display contractual information and use it as a checklist to ensure 
that all elements of the bid process have been completed. 
 
A common tutorial for this part of the BID program is extremely difficult to produce 
because FDOT has complete control over customizing the entry screen. When you get to 
this section, simply enter all the required fields moving through the proposal from top to 
bottom using the scroll bars on the side of the window. When you get to a field that 
requires a choice to be made, click in the field and press the first letter of the word you 
choose and your answer will display. For example, yes or no answers can be entered by 
pressing Y or N. After you filled in all the Miscellaneous Data window fields, click the 
SAVE button on the Toolbar to save the bid. 
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4.1.5 Viewing Proposal Info 
When you need to view basic information regarding a proposal, click the proposal name 
on the left side of the window. For example, suppose you wanted to check the letting date 
for this particular proposal. Click the proposal name. A Proposal Information window 
appears  displaying the letting date as well as other types of information. 
 

 
Basic Information Window 
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4.1.6 Exporting Item Data 
Let's say your company prefers to use a spreadsheet program for entering bids. BID 
allows you to import and export data in several different formats. This feature allows you 
to view your bid in Microsoft Excel. Although the file is saved in a *.csv format, the file 
itself will default to the Excel program. 
 
2 Note: The Export and Import option fields should be the same in each of the 
option selections to ensure file import/export compatibility. Otherwise, data 
exported and edited in third-party software cannot be imported back into 
Expedite. 
 
There is less chance of a data error if you export the bid from BID first, estimate the job 
in Excel, and then re-import the bid into the BID program. Choose Export Proposal from 
the Tools menu to begin the steps of exporting a clean .csv file. 
 
To export a bid into a .csv format, follow the steps below: 
 
1. Select Export Proposal from the Tools menu. The Export Items window appears 
asking you to confirm the export operation. 
 

 
The Export Proposal Window 
 
2. Confirm that the Save as Type field is accurate and click SAVE to export the file in 
the .csv format. If you now look in your directory, you will find the file type you 
requested with the same name as the active bid. 
 
3. Exit BID and run Excel. Use its functions to load the proposal item data file, enter 
your unit price bids, and save. If Excel asks whether to upgrade the file version, 
click NO. 
 
4. Exit Excel and run BID. Load the electronic bid file by selecting Import Proposal 
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from the Tools menu. Press ENTER to confirm the import operation BID will read 
the Excel file and update any unit price bids that have changed. You can save the 
updated electronic bid file and print a paper-based bid. 
 
5. An Import Info window will appear displaying the total number of lines, and the 
total number of bid prices that were imported. Press the OK button to make this 
window disappear. 
 
 
The import/export options are described in Section 5.1.3.  The import and export file 
formats supported by BID are shown below. 
 
File Format Description 
 

File Format Description 
WK1 
(1-2-3 format) 
 

This is a Lotus 1-2-3 native spreadsheet 
format. This is usually the best choice for 
importing and exporting to Lotus 1-2-3 for DOS 
and Windows. 

CSV 
(Comma delimited format) 
 

This is a generic text format that is supported 
by several spreadsheets and many other 
programs. This format represents the data as a 
sequence of fields separated by commas, 
where each line of text corresponds to a row of 
data. Fields with embedded commas or quotes 
are surrounded by quotes. This is a useful 
format for custom estimation systems. 

TAB 
(Tab delimited format) 
 

This is a very simple text format where fields 
are separated by a tab, one line per data row. 
This is a useful format for custom estimation 
systems. 

COL 
(Fixed column format) 
 

This is a text format where each column takes 
up a fixed amount of space. 

DIF 
(Data Interchange Format) 
 

This format can be used by DOS-based 
versions of Lotus, and DBase. 
 

CS2 
(Simplified CSV format) 
 

This is a stripped-down version of the CSV 
format to be read by programs that cannot 
handle CSV correctly, such as Lotus 1-2-3. 
 

DAT 
(Test only!) 
 

This export only format contains all the 
information about a proposal in CSV format. 
This format is intended to be used by 
estimation systems that want to know all about 
the proposal. This format cannot be used to 
import. 

 Supported Import and Export File Formats 
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4.1.7 Printing the Bid Proposal 
Now that the electronic bid is complete, a paper-based version must be produced for 
FDOT. 
 
1. Click the PRINT button on the toolbar. A window will appear asking to save to diskette. 
 

 
 
BID will also display the Print window . This window lists your options for printing 
different parts of the active bid. We will print a Full Bid Report for our purposes. 
 

 
Print Window 
 
2. To print a full BID report, keep the default Print Range of All. 
 
3. Click OK. The electronic bid is sent to the printer. 
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Printing Selected Items in a Bid Proposal 
Occasionally, you may need to create printed quote information on just a few items in a 
proposal. In these cases, you can use the Print Quote option to print information on only 
those items that have been given a unit price in the proposal. 
 
2 Note: The Print Quote option does not perform a check of the bids. 
 
 
Follow these steps to print information on selected items in a proposal: 
 
1. Open the proposal and enter a unit price for all items you want to quote. 
 
2. Select Print Quote from the File menu. BID displays the Print window. 
 
3. Keep the default Print Range of All, and click OK. The selected item bid 
information is sent to the printer. 
 
2 Note: The format for the printed information is defined by an optional set of 
templates in the Gen config file ( this file is controlled by FDOT ) 
 
 
 
4.1.8 Sending Bids Back to the State Highway Agency 
Once you have finished printing a paper-based version of your bid, click the SAVE button 
to save your work. You may send your bids back to FDOT electronically or manually. 
 
Follow these steps to send your bid manually: 
 
1. Copy the electronic version onto a diskette. 
 
2. Deliver the paper-based version of your bid and your diskette to FDOT. 
 
2 Note: Follow your agency's rules about whether to place each bid on 
a separate diskette, or to turn in a single diskette with all your bids for 
the letting. Do not change the file names of your bids because the 
agency will use them when loading and analyzing your bid. Finally, do 
not include any proposal file for which you are not bidding. 
 
 
Follow these steps to submit your bid electronically via the Internet: 
 
1. Select Bid Submission from the Tools menu. 
 
2. Follow the instructions of the bid submission wizard to submit your bid. 
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4.1.9 Using the Log Directory 
Once a bid or a digital ID has been submitted, a log directory is created with a record of 
those submissions. The types of files that are entered into the log directory are bid 
submission and key and bid withdrawal. The file name will reflect the date, time, and 
generation for the submission, plus the type of submission. These text files can be 
retrieved and printed at any time in any text editor for a file record of those actions. 
By default, bid submission errors will not be logged in the log directory. However, if 
your agency wishes to log errors, a parameter can be set in the Expedite Properties 
window to do this.  
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5.0 Customizing BID 
The BID module of Expedite provides user-friendly windows to make changing system 
configurations easier. This section describes these windows, and lists the fields of each 
with a brief description. 
 
BID contains a  Miscellaneous Data Entry screen. This screen can contain anything that  
FDOT would like you to record. Information entered on the Miscellaneous Data Entry 
screen, however, never gets passed back to its bid letting system. Some DOTs use this 
screen to display contractual information and use it as a checklist to ensure that all 
elements of the bid process have been completed. 
 
5.1.1 Primary Windows Fields 
BID provides separate windows for the various types of information.  
Entities accessed are: 
n Proposal 
n Section 
n Item 
 

Label Entity Field Notes 
File   The proposal file name is displayed in the title bar. 

 
Bidder l 

 
Proposal 
Proposal 

Bidder-ID 
Bidder-Name  

Joint Bid  Proposal  Joint-Bid  Displayed with a Yes or No indicator. 
Contract ID  Proposal Contract-ID  
Letting Date   Proposal Letting-Date  
Call Order Proposal Call-Order  
Description Proposal Description  
Section Section  Number Entries for each section are interspersed with line items. 
Alt Group  Section  Alternate-Code  
(Section 
Total)     Generated as the sum of the Extensions of all items in 

this section. 
(Section 
Description)  

Section  Description Only the first line of the multiline description is displayed. 

Line 

 
Item 

 
Line-Number 

 
 

Item Item Item-Number  
Quantity Item Quantity  If the item is a lump sum, the quantity will be displayed as 1.000. 

 
Unit Item Unit-Price May be empty (no price displayed). 
Extension    Generated as the rounded product of the Quantity and 

Unit Price, or as zero if the Unit-Price is empty. 
(Item 
Description)  

Item  Short-Description  
Bid Total    Generated as the sum of all item Extensions. 
    
BID Program Screen Field Descriptions 
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5.1.2 Screen Functionality 
You can work in BID in multiple windows. The main windows can be navigated by 
clicking the name of the window (or DBE or Item depending on the mode) on the left 
side of the main BID window. The main BID window is split into two parts. The left side 
of the window lists choices for the user. The right side of the window displays the 
associated details. Although this list can be shorter based on a state’s settings, these are 
the primary BID windows: 
 
Main   BID initially displays ready for work on the first proposal/bid you desire; 

therefore, the initial screen is blank. 
 

Basic   The Basic window displays the basic information about the proposal/bid 
(e.g., letting date, joint bid indicator). 
 

Schedule of 
Items 

The Schedule of Items window displays either one item at a time or a list of 
items depending on the user’s preference. All associated information is 
also listed (e.g., section totals, proposal total). 
 

DBE, MBE, or 
WBE List 

The DBE (or MBE or WBE) List displays the fields for DBE information. 
If an existing DBE is selected, the associated information displays; 
otherwise, the fields are blank to allow entry. Fields displayed include DBE 
commitment, DBE goal, etc. 
 

Miscellaneous 
Data 

The Miscellaneous Data window is designed by individual DOTs that choose 
to use the flexibility provided by this free form window. 
Whenever the highlighted item is editable (that is, not a section header or a 
fixed-price item) the bidder can enter a new unit price or edit the existing 
unit price. Unit prices can be blanked out; blanks are treated like zero for 
calculations, but print and display differently from zero. Items with blank 
unit prices are not considered for bidding when Expedite checks for errors. 
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5.1.3 Setting Options for the BID Program 
Selecting Options on the Tools menu displays a seven-tabbed window that allows you to 
set options that modify the BID’s operation. The window displays with the default entries 
initially set by the install program. You can alter the user preferences to customize BID to 
meet your needs. Your changes are saved and applied until modified by you again. 
 
Bidder Information Tab 
This tab contains personal information about your company. You can modify your name, 
address, phone number, and other information on the BIDDER INFORMATION tab. 
 

 
 The Bidder Information Tab 
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Agency/ID Tab 
The AGENCY/ID tab is restricted to the Agency and Bidder ID information due to the 
importance of these fields. The Agency field is used to identify the agency involved in 
the bidding. The Bidder ID field is the key displayed to identify the bidder by code. 
 
Special, enhanced functionality is available on this tab. If the PC is available for use by 
multiple bidders, enter the word ASK in the first blank Agency ID row. Every time a 
proposal/bid is opened, the user will be prompted to choose the bidder ID to be associated 
with the current proposal/bid. The user will also have the option to click the more detail 
button to make changes to general company information. This option is for FDOT use 
only and not available in the online help. 
 
This function is available so FDOT can set up public use of PCs with Expedite installed 
for contractors to use to complete their bids. The PCs can be set up in a public library, 
contractor’s associations or the DOT office as desired by FDOT. This is beneficial for 
contractors who can’t afford a computer or need to make last-minute changes on letting 
day and don’t have access to their computer. 
 

 
The Agency / ID Tab 
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Units Tab 
The UNITS tab lists all of the unit types and the conversion amounts. The Unit column 
lists the English abbreviation units; the Alt Unit lists the metric unit abbreviations. The 
Conversion column calculates the conversion of the two, and the Description column 
uses free form text to clarify the conversions. 
 

 
The Units Tab 
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Export Format Tab 
The EXPORT FORMAT tab displays the file an export action will create. This includes the 
selected file format, data elements, and the ability to revert to system defaults, if needed. 
The Field Name defines the field label, and the Field Size defines the length of the field. 
The Default File Format determines what type of file the export will create (e.g., .csv, 
.wk1). The Export Label box is the indicator of whether to include the field name on the 
file. The RESTORE DEFAULTS button sets the window back to the initial system settings. 
 

 
The Export Format Tab 
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Import Format Tab 
The IMPORT FORMAT tab displays the type of file allowed to be imported. This includes 
the selected file format, data elements, and the ability to revert to system defaults, if 
needed. The Field Name defines the field label, and the field size defines the length of the 
field. The Default File Format determines what type of file is being imported (e.g., .csv, 
.wk1). The RESTORE DEFAULTS button sets the window back to the initial system 
settings. 
 

 
The Import Format Tab 
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Export and Import Informational Tables 
The following tables are relevant to import and export functions. 
These are the valid file formats that may be transferred between BID and external 
spreadsheet programs: 
 
CSV   Import or Export using the Comma-separated-value format. 
CS2  Import or Export using a Modified CSV (quotes and commas are stripped 

from strings) format. 
TAB   Import or Export using the TAB-delimited format. 
DIF   Import or Export using the DIF (Data Interchange Format) format. 
COL   Import or Export using the Column-aligned format..5-10 Customizing Expedite 
WK1   Import or Export using the Lotus Spreadsheet format. 
DAT  Dump entire proposal contents in CSV (EXPORT ONLY!) 
 
 
Import and Export Field Data Elements 
The IMPORTFIELDS and EXPORTFIELDS listed below define which data elements 
appear in the columns of the data file. These are the options that are available for you to 
import and/or export. 
 
LineNumber   Item Line Number. 
AltCode   Item Option or Alternate Code (if any). 
ItemNumber   Item Item Number. 
Quantity   Item Quantity. 
Unit   Item Unit. 
UnitPrice   Item Unit Price. 
LumpSumFlag  TRUE or FALSE depending if item is a Lump Sum Item. 
ShortDesc   Item Short Description. 
LongDesc   Item Long Description. 
Skip    A Blank Field. 
SectionNumber  The current section number. 
SectionAlt   The current section Option or Alternate Code. 
SectionDesc  The current section Description. 
LettingDate   The proposals bid letting date. 
LettingID   The letting ID for this proposal. 
CallOrder   The call order for this proposal. 
ContractID   The Contract ID for this proposal. 
Index    A general purpose row counter. 
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Import and Export Field Size Values 
The following is a list of default field sizes. For a spreadsheet format like .csv, these 
entries determine the size of the columns. For the .col format, these values determine the 
exact size of the data fields. To use these entries, simply list the sizes of the fields on the 
appropriate tab (IMPORT or EXPORT). If sizes are not changed, the defaults listed below 
are used. 
 

Value Field Default Value 
LINENUMBER 6 
UNITPRICE  16 
ALTCODE  6 
LUMPSUMFLAG  6 
ITEMNUMBER  15 
SHORTDESC 40 
QUANTITY 16 
LONGDESC  80 
UNIT 6 
 
Default Import/Export File Field Sizes 
 
 
2 Note: At a minimum, the Import field description must include 
LINENUMBER and UNITPRICE. This is because BID uses the 
LINENUMBER value to determine which item to change and uses the 
UNITPRICE value as the new unit price for the item. Note that you 
cannot load prices for fixed-price items..5-12 Customizing Expedite 
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Misc. Tab 
The MISC. tab provides the user with optional, miscellaneous settings not available in the 
prior version of BID. These fields are available on the MISC. tab: 
 
Save Before Printing  Saves the bid prior to printing 
 
Check Before Printing  Checks the bid prior to printing 
 
Delete Warnings   Does not display warning error messages in BID 
Show Splash Screen at Displays the BID graphical window at log on 
Startup 
 
Save Window Position on Displays BID in the same position on the PC as the prior 
Exit     session 
 
Ask to save to floppy Implements an additional prompt to remind bidders that, after 
when saving entering new bid information, they need to save the bid file to 

a floppy disk. 
 

 
The Misc. Tab 
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Proxy Tab 
The PROXY tab is only required when the BID program is run in a network environment 
where a proxy server is used. Contractors who wish to submit bids via the Internet and 
are operating in a proxy server environment must fill in the PROXY tab in order for the bid 
submission to work properly. If you do not have this information, contact your 
company’s or organization’s network systems administrator. If you do not use a proxy 
server, leave all fields blank. 
 
To fill in the PROXY tab do the following: 
 
1. Make sure the Use Proxy field is checked. 
2. Fill in your Proxy Server Address. 
3. Fill in your Port number. 
 

 
Figure 5-8. The Proxy Tab 
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5.1.4 Sharing Option Settings 
Ordinarily, BID saves the option settings you make to a default file called the Windows 
registry. However, if you want to be able to Share or transport your settings between PCs 
or on a network, you can store them in a specific file that BID will use instead of the 
registry. This file must be named bid.ini and must reside in the same directory where you 
have installed BID. 
 
Follow these steps to create the bid.ini file: 
 
1. Finish setting all options in the Bid Options tab window. 
 
2. Select Export Configuration from the Tools menu. Trns•port displays the Export 
Bid Configuration File window with the correct directory already entered in the 
Save In textbox and bid.ini entered in the File Name textbox..5-14 Customizing Expedite 
 
3. Click OK to save the new bid.ini file. 
 
To use the option settings from another BID installation, import the bid.ini file from that 
installation to the directory where your BID program is installed. 
 
 
2 Note: The user whose option settings you want to share must first have 
created the bid.ini file using the Export Configuration feature for their own BID 
installation. 
 
Follow these steps to import the file: 
 
1. Open your installation of BID and select Import Configuration from the Tools 
menu. Expedite displays the Import Bid Configuration File window with the correct 
directory entered in the Save In textbox. 
 
2. In the File Name textbox, browse through the Network Neighborhood to the 
directory where the bid.ini file resides and select it. Click OK. 
 
3. Expedite copies the bid.ini into the appropriate directory for your installation. 
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5.1.5 Other Settings 
Windows Printer Settings 
As in other Windows applications, the printer settings can be modified via the Printer 
Setup option on the File menu. The settings available to be modified are: 
 
Name  Select the printer you want to use. Choose the Default Printer; or 

choose the Specific Printer option and select one of the current 
installed printers shown in the box. You install printers and configure 
ports using the Windows Control Panel. 

 
Properties  Displays a Properties dialog box, so you can select paper standards to 

be used. 
 
Paper Size   Select the size of paper on which the proposal is to be printed. 
 
Paper Source  Select the paper tray for printers that offer multiple trays for different 

paper sources. 
 
Orientation   Choose Portrait or Landscape. 
 
 
Additional factors are modified via the Print option on the File menu as defined below: 
 
Name  This is the active printer and printer connection. Choose the Setup 

option to change the printer and printer connection. 
 
Properties  Same as above. 
 
Print to file  Displays a dialog box, so you can select where you want the file 

saved. 
 
Print Range Specify the pages you want to print (all, specific pages, or highlighted 

selection). 
 

Copies  Specify the number of copies you want to print for the above page 
range. 

Collate Copies Prints copies in page number order, instead of separated multiple 
copies of each page. 

 
Once the appropriate selections have been made, click OK to print or CANCEL to return to 
BID. 
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Appendix A. Digital Signature Overview 
Digital signature technology is central to the Windows version of Expedite. This 
appendix explains the basics of digital signature evolution and technology. 
 
A.1 Purpose of a Signature 
Traditionally, a signature on a document serves many purposes. First, it identifies the 
signer. Second, it indicates the signer’s acceptance of the document. Third, it implies an 
understanding of the consequences of signing the document. For example, a name written 
on a contract in an area labeled “write your name as you would like it to look on a 
plaque” is not a signature because it does not indicate acceptance. A name written in 
frosting on a cake would not be a signature because it is unlikely that that the signer 
understood that to be a meaningful signature. 
 
Courts have generally held that a signature does not have to be handwritten, provided the 
above requirements are met. Illiterate people have long been able to simply make any 
mark rather than write their names as a signature. A rubber stamp is often acceptable as a 
signature, as are telegraphed names, typed names, and even names on e-mail messages. 
The courts have stopped short of accepting spoken words as signatures, however. 
Based on court findings, a digital signature should be simple to provide: simply type your 
name in a file (or even click on a graphical button). These kinds of “signatures” may be 
acceptable in court, but they don’t protect you very well. They are easy to forge and thus 
easy to repudiate. 
 
If they are ever disputed, it is unlikely that a court will be able to determine the basic 
facts needed to assess the existence of a valid signature. For that reason, cryptographic 
technology is used to create digital signatures, which preserves the intent of a signature, 
while being very difficult to forge or repudiate. 
 

A.2 Cryptography 
At first glance, cryptography does not seem to have anything to do with signatures. 
Encryption is for keeping secrets, not for verifying identities. However, it turns out that 
encryption does provide some excellent methods for digital signatures. Some background 
is required to understand it, however. It has always been important to protect the contents 
of confidential messages, in case the message is intercepted. Encryption provides a way 
of scrambling a message so that only the proper party can understand it, whether or not 
the scrambled message has been disclosed. Encryption is thousands of years old; even 
Julius Caesar used a simple substitution cipher to protect his communications. Encryption 
is particularly important in electronic communications because of the ease of covertly 
intercepting confidential messages. 
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A.2.1 Single Key Encryption 
The most common forms of encryption use a single key, which is used to both encrypt 
and later decrypt the message. The original message is called the plaintext; the encrypted 
form is known as the ciphertext. The encryption algorithm has a complementary 
decryption algorithm. The recipient uses the same key to reverse the operation. 
 
Creation of encryption algorithms is as much art as science. The algorithm must destroy 
any patterns in the plaintext that would assist in analysis of the ciphertext. For example, 
any simple substitution cipher, where each character is replaced with a different 
character, is easy to break for English language text; just count the frequency of each 
character in the ciphertext. The most common is probably the substitute for “e”; if not, 
it’s likely the substitute for “t” or “a”. A good encryption algorithm is not susceptible to 
this kind of attack. There are a variety of good single key encryption algorithms in use 
today. One of the most common is DES, the U.S. data encryption standard. Others 
include IDEA, RC4, and RC5. 
 
When an algorithm is in general use, its weaknesses have been probed by the encryption 
community, and you can count on it being quite secure. For these strong algorithms, the 
only practical attack is a “brute force” approach, where every possible key is tried until 
one works. An encryption algorithm’s susceptibility to a brute force attack depends 
almost entirely on the number of possible keys that must be tested. DES is defined only 
for 56 bit keys, which is on the verge of being too easy to break by brute force. A variant 
of DES called triple-DES has 112 bit keys, IDEA uses 128 bit keys, and many other 
algorithms can use variable key lengths. 
 
Weakness of 56 Bit, Single-Key Encryption 
The growth of the Internet has led to a unique public testing ground for encryption 
algorithms. Companies release encrypted messages and enthusiasts band together to 
decipher them. One well-organized group, called distributed.net, recently cracked a 56-bit 
DES encrypted message. It took them just over 40 days using tens of thousands of 
computers (the computational equivalent of 22,393 Intel Pentium II PCs at 333 MHz 
each). The group had to test about 63,686,000,000,000,000 keys out of a possible 
72,057,594,037,927,936 to find the correct one. 
 
That’s not exactly easy, and DES cannot really be called weak. However, we can expect 
computing advances to make this several times easier to do each year. Simply moving to 
64 bit keys would require 256 times as much computing power to crack (or about 30 
years with the computing power of distributed.net). Moving to 128 bit keys extends the 
power enormously. Cracking that, given the same conditions as used by distributed.net in 
the example above would require 500,000,000,000,000,000,000 years or about 100 
billion times the current age of the universe. It seems that 128 bit keys are secure for a 
while to come. 
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Managing Single-Key Encryption 
The biggest problem using single key encryption to keep information secret is managing 
the key. The two parties wishing to communicate must share a key. If that key is 
intercepted or stolen, all messages can now be read by a third party. Another problem is 
that single key encryption is not very useful for authentication. If parties Alpha and Beta 
share a single key, and Alpha receives a message encrypted with that key, Alpha could 
reasonably assume that Beta had created the message. However, if Beta wanted to 
repudiate the message, he could credibly claim that Alpha had actually created the 
message and was trying to impersonate Beta. 
 
A second problem with single keys is related to the first: they do not serve the needs of a 
group well. If all the members of a group trust one another, they can share a single key, 
and they can all read each other’s messages. However, a single untrustworthy, or 
incompetent, group member can disclose the key and compromise all communication 
within the group. 
 
A.2.2 Public Key Encryption 
In the late 1970s, Diffie and Helman proposed a method to allow two parties to 
communicate without sharing a single key. The Diffie-Helman algorithm was complex, 
and was never widely used. However, shortly after that point, Rivest, shamir, and 
Adelman developed the RSA algorithm that served the same purpose. Since then, a 
mathematically similar algorithm was developed by El Gamal. All these algorithms share 
an important feature: they use a pair of keys, instead of a single key, and the holder of 
either key in the pair can securely communicate with the holder of the other key. The 
remaining discussion will focus on RSA, although the other algorithms behave in a 
similar manner. 
 
The first step to using RSA is the creation of a key pair. This requires generating two very 
large prime numbers. Each key in the pair is based, in different ways, on these two prime 
numbers. There is no mathematical difference between the two keys in a pair, but one of 
them must be selected to be the public key and the other one to be the secret key. 
The vital fact about RSA (and all public key cryptosystems) is that any message 
encrypted by one key in the pair can only be decrypted using the other key in the pair. 
That means that Alpha can keep his secret key to himself and tell the world his public 
key. Anyone can use Alpha’s public key to send him a secret message that only Alpha’s 
secret key can decode. 
 
Public key encryption eliminates the problem of transferring keys secretly between two 
parties, and protects against the bad faith or incompetence of other parties. No one can 
disclose Alpha’s secret key except Alpha, because no one else ever needs to see it. 
There is a wonderful side effect of public key encryption: it can be used “backwards” for 
authentication. That is, Alpha could encrypt a message with his secret key and anyone 
else can read it using his public key. This is not useful for keeping secrets, since anybody 
can read the message, but it is perfect for authenticating the sender. Only Alpha has his 
secret key, so only Alpha could have written the message. 
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A.2.3 Digital Signature Practicalities 
RSA and similar algorithms are relatively slow, and encrypting and decrypting large 
messages is expensive. All real digital signature algorithms actually extract a message 
digest (or hash) of the original plaintext and encrypt that instead. A hash function is a 
one-way transformation of the original text, usually to a smaller size. Any change in the 
original text will change the resulting hash value. For example, a checksum is a type of 
hash function; no matter how large the original text, the checksum is always the same 
size. It is common to send a checksum along with a message to make sure that there was 
no data lost in transmission, since any change in the text would change the value of the 
checksum. A cryptographic hash can serve a similar function. 
 
A typical digital signature protocol will send the original text, along with its hash value 
encrypted using the secret key. Any recipient decrypts the hash, then creates another hash 
of the received text using the same algorithm. If the two hashes match, the message is 
authenticated.  First, Alpha signs a message. The combination of the original plaintext 
and the encrypted hash form a signed message. Any recipient can verify the signature 
using the public key. If the two hashes match, the signature is considered to be good 
because only Alpha, the holder of the secret key, could have created the signed message.  
 
This derives from three points: 
 
1. Only the holder of the secret key could have created the encrypted hash. That is 
verifiable because the encrypted hash could be decrypted with the public key. 
 
2. Only Alpha knows the secret key because Alpha keeps it secret, and it cannot be 
derived from other information. 
 
3. Only the particular plaintext message could have created the particular hash value. 
Point 1 is true based on everything known today about RSA. Point 2 is true for practical 
purposes only; it turns out that the secret key can theoretically be derived from the public 
key. However, the computation required makes cracking a 128 bit single key seem easy. 
Point 3 is false; different plaintext messages could have created that same hash value, but 
the odds of two different random messages having the same hash value are very small, 
only 1 in 2^128 (about 1 in 340,000,000,000,000,000,000,000,000,000,000,000,000). 
Thus, point three is also true for practical purposes. 
 
 
2 Note: Point 3 is true only if different messages are tried at random. If the 
hash function is as simple as a checksum, a malevolent person could copy 
the original plaintext and encrypted hash, and substitute a different plaintext 
with the same hash. Thus, the hash function used for a digital signature must 
be cryptographically secure, which means it must be computationally 
infeasible to generate additional documents with a given hash value. 
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A.2.4 Public Key Encryption Practicalities 
The same computational complexity that leads to the use of a hash for a digital signature 
also causes problems when using public keys for secrecy. It is not practical to encrypt a 
long message with this algorithm. The solution to this problem is ingenious: the creator 
of the message also generates a traditional single key, called a session key because it is 
used for just one message. This session key is used to encrypt the message, using 
traditional single key encryption. The session key itself is then encrypted using public 
key encryption, and passed along with the message, as shown below. In this way, 
anybody can send a message that can only be read by the intended recipient. 
Only the intended recipient can read the message because it requires use of the recipient’s 
secret key. 
 
 
A.2.5 Public Key Weaknesses 
There are many ways to attack both encryption and signatures based on public key 
encryption. Each algorithm must be secure, or the entire structure can be cracked. 
 
1. The RSA encrypt and decrypt algorithm must be unbreakable. There must be no 
way to recover plaintext given the ciphertext and the encryption key only. RSA 
does appear to meet this requirement. A message encrypted in the late 1970s with 
a 129 digit key (about 430 bits) was broken only 20 years later. It is generally 
considered that a 512 bit RSA key is secure for commercial use. However, keys 
as large as 2048 bits are practical today and are considered extremely secure. 
 
2. The algorithm for creating an RSA key pair must not be predictable. It does no 
good to have an unbreakable algorithm if the software originally used to create the 
key pair can be used to recreate the same key pair independently. This requires 
strong random number generators and the use of some input that varies every time 
the software is executed. 
 
3. The single key encryption algorithm must be unbreakable. There must be no way to 
recover plaintext without the key. DES is considered unbreakable except through 
brute force. Triple-DES, IDEA and RC5 are also considered unbreakable and 
allow much larger key sizes, and are much more difficult to attack using brute force. 
 
4. The session key generator must not be predictable. Again, this requires good 
random number generators. An early version of Netscape Navigator was cracked 
not because the 40 bit session keys were too short, but because many of the bits in 
the keys were predictable. 
 
5. The hash function must be one-way. If someone can figure out how to create 
messages that match existing hash functions, they can create falsely signed 
documents. 
 
6. The source plaintext documents and unencrypted session keys must be kept truly 
secret. It does no good to send a message in a secure manner if an attacker can 
simply access the source computer to read the original documents. 
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7. Your secret keys must be kept truly secret. Again, it is not necessary for someone 
to crack the key using sophisticated techniques if he or she can just take it off the 
source computer. For that reason, the secret keys are stored in encrypted form; the 
single key required to decrypt it is based on a password you must remember. 
Since the required single key is created from information you can memorize, it need 
never be stored permanently, so it cannot be compromised. 
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Appendix B. Expedite Tree Mode and Grid Mode 
Figure B-1 shows the Expedite tree mode. The left section holds the tree information, 
while the right section displays the detail information based on the section level of 
expansion. You click on + to expand the tree or – to collapse the tree. 
 
B.1 Bid Tree Mode 
 

 
Figure B-1. Expedite Tree Mode 
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B.2 Bid Grid Mode 
 
Figure B-2 shows the Expedite grid mode. The grid mode is similar to the DOS Expedite 
view. In the grid mode the proposal item schedule, DBE and Misc. Proposal information 
are displayed in a grid on the right section. You must scroll up and down to see the entire 
items list, all DBE information or all Misc. Proposal information. 
 

 
Figure B-2. Expedite Grid Mode 
 
 




